Release notes

SMART Meeting Pro™ software

About these release notes

These release notes summarize the changes in SMART Meeting Pro™ software (formerly SMART
Meeting Pro 2010 software) and its service packs.

Product information
SMART Meeting Pro software is designed specifically for meeting management on SMART Board™
interactive whiteboards.

The SMART Business Toolbar and intuitive interactive whiteboard features make SMART Meeting
Pro software easy to use, so you can deliver better meetings and better results.

Extraordinary made simple™ ‘ SMAKRT.
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About this release
This release includes support for new SMART interactive products and bug fixes.

Software component version numbers

Component Version Date (if applicable)
SMART Meeting Pro software 2.2.141.1 March 31, 2011
SMART Product Drivers 10.7.182.1 March 1, 2011
SMART GoWire™ auto-launch cable updater 2.2.203.1 March 31, 2011

SMART Product Drivers on the SMART GoWire auto-

launch cable

10.7.90.1 March 1, 2011

Visual C++® 2008 SP1 Redistributable 9.0.30729.17

Computer requirements
No change from previous computer requirements.

Highlights

Support for the wireless connection for SMART Board 800 series interactive whiteboards

Support for SMART Board 8070i interactive displays

Resolved issues

Digital ink no longer shifts when you set the display to an aspect ratio other than 4:3.
Digital ink displays more quickly and is thicker in PowerPoint® presentations.

The Restore Ink bubble is better positioned on the display.

A Restore Ink button has been added to Microsoft® Office.

The save-on-close feature is improved.

If you take a screen capture of your notes on the Ink Layer, messages that appear will be
complete.

You can save a PowerPoint file in SMART Meeting Pro software.
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Translation issues

e When you press the SMART Meeting Pro icon, the names of the SMART Tools are in the
language you installed.

e Inthe SMART Software Activation window, the Product Key Help link is in the language you
installed.

Known issues

e When you disconnect your SMART GoWire cable before you exit, SMART Meeting Pro
software appears.

e When you connect your SMART GoWire cable to a computer that is not connected to an
interactive whiteboard, the SMART GoWire cable stops responding instead of exiting.

o If you use the Reset Room feature while the Spotlight or Screen Shade tool is in use, those
tools permanently disable until you exit and then start SMART Meeting Pro software.

Translation issues
o« When you work with text in Whiteboard mode, the title on the Fonts toolbar is in English,
regardless of the language you install.

e The SMART Video Recorder title bar is in the incorrect language when you install your software
in Dutch or German.

Related release notes
SMART Product Drivers (smarttech.com/kb/132754)



http://www.smarttech.com/kb/132754
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About this release
This is the 2.2 release for SMART Meeting Pro software. This release contains the SMART GoWire
auto-launch cable updater, new features and bug fixes.

Software component version numbers

Component Version Date (if applicable)
SMART Meeting Pro software 2.2.140.0 November 25, 2010
SMART Product Drivers 10.7.82.0 November 19, 2010
SMART GoWire auto-launch cable updater December 1, 2010
SMART Product Drivers onthe SMART GoWire

10.7.80.0
auto-launch cable
Visual C++® 2008 SP1 Redistributable 9.0.30729.17

Computer requirements
e Windows® XP SP3 or Windows 7 operating system (disabling Advanced Aero® theme
recommended)

¢ DirectX® technology 9 or later

e 2 GHz dual core processor, or faster (quad-core recommended)

o 1GB of RAM (Windows XP operating system) or 4 GB of RAM (Windows 7 operating system)
o Discrete 128 MB VRAM and support for DirectX 9 technology

o 1 GB of free hard disk space (additional free space required during installation)

e 10 Mbps network connection (100 Mbps recommended) supporting TCP/IP
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Supported languages

Hig

English (U.S.) o Japanese

English (United Kingdom) « Norwegian

Chinese (Simplified) o Portuguese (Brazil)
Czech o Portuguese (Portugal)
Danish ¢ Russian

Dutch ¢ Spanish (Mexico)
French (France) ¢ Spanish (Spain)
German e Swedish

Italian o Turkish

hlights

You can add, delete or clone a Whiteboard page by right-clicking its thumbnail image in the
Page Sorter.

You can create shape, line and text objects using the Shapes and Text tools.

You can place a link on a page or on an object on a page to a website, to another page in the
file, to a file on your computer or to an attachment.

You can rotate an object to any angle you want on your Whiteboard page. You can also
duplicate an object over and over using the clone feature.

You can manipulate objects you create by accessing the Object menu. You can lock, group
and flip objects. You can also change the order of stacked objects and manipulate object
properties.

You can insert images in a variety of file formats to your Whiteboard page by selecting Insert >
Image from the menu bar.

Autosave provides automatic protection and recovery of your documents in the event of a
system failure.

Enhanced support for SMART interactive products that recognize multitouch gestures and
Touch Recognition. You can use multitouch gestures to navigate Whiteboard pages,
manipulate objects and move and flick objects across your screen.

On a SMART Board 800 series interactive whiteboard, two users can create and manipulate
objects in SMART Meeting Pro software at the same time.

Added support for the new SMART Board 800 series interactive whiteboard and the SMART
Board 8070i interactive display.
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e You can update your SMART GoWire auto-launch cable for SMART Meeting Pro software at
smarttech.com/software.

Known issues
¢ If you use the Reset Room feature when the Spotlight or Screen Shade tool is in use, those
tools permanently disable until you exit and start SMART Meeting Pro software.

o If you take a screen capture of your notes on the Ink Layer, you might receive messages that
appear incomplete.

o If you save a PowerPoint file in SMART Meeting Pro software, the software stops responding
or behaves unexpectedly. A Windows dialog box might appear indicating PowerPoint has
stopped responding. Start PowerPoint first, and then repeat the save file operation from
SMART Meeting Pro software.

Translation issues
o When you work with text in Whiteboard mode, the title on the Fonts toolbar is in English,
regardless of the language you install.

o The SMART Video Recorder title bar is in the incorrect language when you install your software
in Dutch or German.

e When you press the SMART Meeting Pro icon, some of the names of the SMART Tools are in
English, regardless of the language you install.

o Inthe SMART Software Activation window, the Product Key Help link is in English, regardless
of the language you install.


http://www.smarttech.com/software
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About this release
This is the 2.1 SP1 release for SMART Meeting Pro software. This release contains new features and
bug fixes and is compatible with the Windows 7 operating system.

Software component version numbers

Component Version Date (if applicable)
SMART Meeting Pro software 2.1.160.1 August 16, 2010
SMART Product Drivers 10.6.175.2 July 30, 2010

Computer requirements

Operating systems
e Windows XP SP3

o Windows 7 for 32-bit and 64-bit processors

Hardware requirements
No change from previous Hardware requirements on page 12.

Software requirements
No change from previous Software requirements on page 12.

SMART hardware supported
No change from previous SMART hardware supported on page 12.
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Supported languages
o Chinese (Simplified)

o Chinese (Traditional)

e Czech

o Danish

o Dutch

o English

o English (United Kingdom)
e Finnish

o French (France)

e German

o Greek

o Hungarian

Highlights
e Full Whiteboard mode

e Save your meeting notes as a .pdf or a .ppt file.

Icelandic
Japanese
Norwegian

Polish

Portuguese (Brazil)
Portuguese (Portugal)
Romanian

Russian

Spanish (Mexico)
Spanish (Spain)
Swedish

Turkish

¢ Available on the SMART GoWire auto-launch cable for SMART Meeting Pro software (GW-

MP).

¢ You can e-mail .pdf, .notebook and .ppt files to meeting participants.

Resolved issues

e If youremove SMART Meeting Pro software while it's running and you have unsaved content
open, a dialog box appears asking if you want to save your changes. After 30 seconds SMART
Meeting Pro software closes without saving and you’re unable to interact with the left margin of
your desktop. If you log off and log on to your computer, you're once again able to interact with

the left margin of your desktop.

o If you're using the SMART GoWire auto-launch cable for SMART Meeting Pro software (GW-
MP) and you disconnect it while SMART Meeting Pro software is running, the software closes

without saving.
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About this release
This is the 2.1 release for SMART Meeting Pro software. This release contains new features, bug
fixes and is compatible with the Windows 7 operating system.

Software component version numbers

Component Version Date (if applicable)
SMART Meeting Pro software 2.1.68.0 February 6, 2010
SMART Product Drivers 10.6.49.0 January 29, 2010

Computer requirements

Operating systems
e Windows XP SP3

e Windows Vista® for 32-bit and 64-bit processors

H nNoTE

SMART Meeting Pro software on your SMART GoWire auto-launch cable doesn’t work with
the Windows Vista operating system.

e Windows 7 for 32-bit & 64-bit processors

Hardware requirements
No change from previous Hardware requirements on page 12.

Software requirements
No change from previous Software requirements on page 12.

SMART hardware supported
No change from previous SMART hardware supported on page 12..
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Supported languages

e English (U.S.) Icelandic
« English (United Kingdom) Japanese
o Chinese (Simplified) Norwegian
o Chinese (Traditional) Polish

Czech

Portuguese (Brazil)

o Danish Portuguese (Portugal)

o Dutch Romanian

o Finnish Russian

o French (France) Spanish (Mexico)

o German Spanish (Spain)

o Greek Swedish

o Hungarian Turkish
Highlights

o SMART Meeting Pro software is available online or by CD installation.
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You can move the main toolbar to either side of the interactive whiteboard, allowing you to
choose where to stand when presenting.

You can change your pen to a green or yellow highlighter to emphasize areas of the whiteboard.

In addition to the calligraphy pen that smoothes your writing, you can use a standard pen that
doesn't. Your system administrator can designate either as the default pen type during or after
installation.

You can resize objects in the whiteboard area.
You can undo and redo actions.

You can cut, copy and paste from SMART Meeting Pro software to other applications and vice
versa.

You can take a screen capture with a button on the business toolbar.
You can print the .notebook file to the designated printer for your computer.
You can save your meeting notes as a .pdf file.

You can e-mail your .pdf or .notebook file to meeting participants.Your system administrator
can configure e-mail settings during or after installation.

Your SMART Meeting Pro software will check for software updates every 30 days. You can set
this as frequently as every day, or as rarely as 60 days.
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You can reorder pages in the page sorter by dragging and dropping them.

Forced compatibility between SMART Meeting Pro software and your SMART Board
interactive whiteboard drivers.

Resolved issues

Page Sorter is updated correctly when you add or delete pages.

You are always able to exit SMART Meeting Pro software using the icon in the notification
area.

Known issues
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When you use the eraser brush to remove highlighter, erasing may lag behind your brush
position. If applying more than minor touch-ups, you may prefer to select a large highlighted
area and delete it by pressing Edit > Delete.

If you are using the SMART Write keyboard, and then pick up a pen from the pen tray, the ink
layer blocks the Write keyboard. Use the SMART Classic keyboard instead.

If you touch the upper right corner of the interactive whiteboard, the ink layer might open
blocking the red close button. If you resize the application to move the red close button from the
upper right corner, it should become accessible and functional.

If you remove SMART Meeting Pro software while it is running, the left margin of your desktop
becomes unavailable. Close SMART Meeting Pro software before removing it. If you didn’t, log
off the computer and log on again to restore your desktop.

If you don't save the writing on your ink aware application before pressing Reset Room, you
will experience Windows error messages as SMART Meeting Pro software resets. The writing
on the ink aware application is lost.

When you press Show Desktop on the task bar, SMART Meeting Pro software is no longer
displayed. Press Show Desktop a second time to have SMART Meeting Pro software
displayed again.

When you press an international link in SMART Meeting Pro software, you might experience
the “Page Not Found” message. Go to smarttech.com and press the International link to obtain
international support.


http://www.smarttech.com/
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About this release
This was the initial release for the SMART Meeting Pro 2010 business software.

Software component version numbers

Component Version Date (if applicable)
SMART Meeting Pro software 2.0.12.0 November 20, 2009
SMART Product Drivers 10.0.532.7 November 20, 2009

Computer requirements
Operating systems
e Windows XP SP3

o Windows Vista for 32-bit and 64-bit processors

Hardware requirements
e 1 GHz Pentium® 4 processor or faster
e 1GB RAM (2 GB recommended)

e 275 MB disk space for minimum installation (1.35 GB recommended)

10 Mbps network connection (100 Mbps recommended) supporting TCP/IP

Video card support for DirectX technology

Available powered USB or serial port

Software requirements
e DirectX 9 or later (recommended)

¢ Internet Explorer® 6.0 or later

e Adobe® Reader® 5 or later (recommended)
SMART hardware supported

e SMART Board 600 series interactive whiteboards.

e SMART Podium™ and Sympodium™ DT770, ID250, ID350, ID370 and ID422w interactive
pen displays.
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Supported languages

o Chinese (Simplified) ¢ Spanish (Spain)
o English o Portuguese (Portugal)
« English (United Kingdom) e Spanish (Mexico)
o French (France) ¢ Spanish (Spain)
o German
Highlights
e SMART Business Toolbar

Includes basic whiteboard tools, such as four pen colors, four pen thicknesses and three eraser
widths.

Whiteboard mode

Operates as a standard digital whiteboard. Basic capabilities include cut, copy and paste,
accessible through the menu or keyboard shortcuts.

Ink Aware
You can use an Ink Aware Desktop mode to write over other software running on your desktop.
Reset Room

After your meeting you can use this feature to close your notes and prepare SMART Meeting
Pro software for the next meeting.

SMART Tools

Includes Screen Shade, Spotlight, Magnifier, Calculator, Pointer, Screen Capture Toolbar and
SMART Video Player.

Save meeting notes to .notebook or .ppt files.

Did this document provide the information you were looking for? If you have any questions or
suggestions about how we can improve this or other SMART documents, please e-mail us at
DocumentationFeedback@smarttech.com.

www.smarttech.com/support | www.smarttech.com/contactsupport
Support +1.403.228.5940 or TollFree 1.866.518.6791 (U.S./Canada)

© 2011 SMART Technologies ULC. All rights reserved. SMART Board, SMART Meeting Pro, SMART GoWire, SMART Podium, Sympodium, smarttech, the SMART
logo and all SMART taglines are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. Microsoft, Windows, Windows
Vista, PowerPoint, Aero, Visual C++, Internet Explorer and DirectX are either registered trademarks or trademarks of Microsoft Corporation in the U.S. and/or other
countries. All other third-party product and company names may be trademarks of their respective owners. Contents are subject to change without notice. 05/2011.
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